Copyright © 2003 ASUSTeK COMPUTER INC. All Rights Reserved.

No part of this manual, including the products and software described in it, may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language in any form or by any means, except documentation kept by the purchaser for backup purposes, without the express written permission of ASUSTeK COMPUTER INC. ("ASUS").

Product warranty or service will not be extended if: (1) the product is repaired, modified or altered, unless such repair, modification of alteration is authorized in writing by ASUS; or (2) the serial number of the product is defaced or missing.

ASUS PROVIDES THIS MANUAL “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL ASUS, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF PROFITS, LOSS OF BUSINESS, LOSS OF USE OR DATA, INTERRUPTION OF BUSINESS AND THE LIKE), EVEN IF ASUS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES ARISING FROM ANY DEFECT OR ERROR IN THIS MANUAL OR PRODUCT.

SPECIFICATIONS AND INFORMATION CONTAINED IN THIS MANUAL ARE FURNISHED FOR INFORMATIONAL USE ONLY, AND ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE, AND SHOULD NOT BE CONSTRUED AS A COMMITMENT BY ASUS. ASUS ASSUMES NO RESPONSIBILITY OR LIABILITY FOR ANY ERRORS OR INACCURACIES THAT MAY APPEAR IN THIS MANUAL, INCLUDING THE PRODUCTS AND SOFTWARE DESCRIBED IN IT.

Microsoft, Activesync, Outlook, Pocket Outlook, Windows, and the Windows logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or in other countries. Microsoft products are licensed to OEMs by Microsoft Licensing, Inc., a wholly owned subsidiary of Microsoft Corporation.
Contents at a glance

This user’s manual contains the information you need to efficiently use ASUS® MyPal A620 Pocket PC.

• Chapter 1 - Get started!.............................................................. 1-1
  This chapter introduces the ASUS MyPal A620 Pocket PC, how to set and power it up, and basic screens that will familiarize you with its many features.

• Chapter 2 - Learn the basics ..................................................... 2-1
  This chapter will teach you the basic functions in MyPal A620. You will learn how to enter, find, and organize information, customize the device, and use the bundled ASUS utilities.

• Chapter 3 - Microsoft® ActiveSync® ........................................... 3-1
  This chapter tells you how to use the Microsoft® ActiveSync® to synchronize your device with your desktop computer.

• Chapter 4 - Microsoft® Pocket Outlook ..................................... 4-1
  This chapter details the procedures for the Microsoft® Pocket Outlook Calendar, Contacts, Tasks, Notes, and Inbox.

• Chapter 5 - Companion programs.............................................. 5-1
  This chapter includes information on Pocket Word, Pocket Excel, MSN Messenger, Windows Media Player for Pocket PC, and Microsoft Reader.

• Chapter 6 - Pocket Internet Explorer ......................................... 6-1
  This chapter gives information and procedures on using Pocket Internet Explorer, Mobile Favorites folder, and AvantGo interactive service.

• Chapter 7 - Get connected ......................................................... 7-1
  This chapter provides the procedures for connecting to the Internet, and for transferring data using infrared (IR) and Bluetooth.

• Appendix - Notices ..................................................................... A-1
  This part includes the safety notices and regulations.
MyPal A620 specifications

<table>
<thead>
<tr>
<th>Processor</th>
<th>Intel PXA255 400 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>Microsoft Pocket PC 2003</td>
</tr>
</tbody>
</table>
| Memory                 | 64MB SDRAM *(58.6 MB user accessible)*  
32MB Flash ROM |
| Display                | 3.5-inch, 240x320 pixels  
65,536 colors, Transflective TFT LCD |
| Card slots             | CompactFlash (CF) Type II slot |
| Infrared               | FIR/SIR |
| Audio                  | Stereo headphone jack  
Built-in microphone  
Built-in speaker |
| Size                   | 125 mm x 76.8 mm x 13.3 mm (L x W x H)  
4.92 in. x 3.02 in. x 0.52 in. (L x W x H) |
| Weight                 | Approximately 141g |

MyPal A620 package

Your package includes several accessories for the Pocket PC. After unpacking, check the items against the list below and make sure that they are in good condition. If any item is missing or damaged, contact your dealer or retailer immediately.

### Standard package contents
- ASUS MyPal A620
- USB cradle with sync cable
- AC adapter  
  - Input: 100V~240V  
  - Output: 5V 2A 10W
- Stylus
- Microsoft Companion CD
- Bonus CD (optional)
- User’s Manual
- Quick Start Guide
- Warranty card

### Optional accessories
- Stylus
- Car charger
- Foldable keyboard*
- Leather handheld case
- Leather waist case
- Traveling USB sync cable
- Cradle with cable
- AC adapter with plug  
  (UL/CEE/UK/SAA/CCEE)
- GPS mouse
- CF GPS card
- CF Bluetooth card
- CF wireless LAN card
- CF LAN card
- CF modem card
- CF camera card
- CF VGA card
- CF FM radio card
- CF GPRS card

* English version keyboard. Visit the ASUS website to check the availability of other language version keyboards.
Chapter 1

Get started!

♦ Introducing MyPal .................................................. 1-2
  Front features ................................................................. 1-2
  Side features ................................................................. 1-3
  Top features ................................................................. 1-4
  Bottom features ............................................................. 1-4
  Back features ............................................................... 1-5
  The stylus ................................................................. 1-5
  The cradle ................................................................. 1-6

♦ Setting up MyPal ................................................... 1-7
  Placing on the cradle .................................................... 1-7
  Connecting the AC adapter ............................................ 1-7
  Installing and removing a CF card ................................. 1-8
  Charging the battery .................................................... 1-10
  Activating MyPal ....................................................... 1-10

♦ Basic screens on MyPal ...................................... 1-11
  Today screen ............................................................. 1-11
  Start menu ............................................................... 1-12
  Command bar ........................................................... 1-13
  Pop-up menus .......................................................... 1-13
Introducing MyPal

The ASUS® MyPal A620 is truly a good companion wherever you go. Powered by a 400MHz Intel® PXA255 processor, equipped with 64MB SDRAM and 32MB Flash ROM, and bundled with the latest Microsoft Pocket PC 2003 plus a host of useful utilities, you have everything you need in your pocket!

Front features

- **Power/Backlight button** - turns the device power on or off if you press the button quickly. Pressing and holding the button for a few seconds turns the backlight on or off. Turning off the backlight saves battery power.

  **NOTE** Press this button and the Tasks button simultaneously if you wish to launch the Align Screen function.

- **Record/Notes button** - allows you to record sounds and save them as files if you press and hold the button, or launches the Notes program when pressed once.

- **Built-in microphone** - magnifies your sound recording.
• **LCD touch screen** - allows you to enter, read, send, receive, or edit data by tapping on it. The screen lumination is increased or decreased by changing the backlight settings.

• **ASUS Settings, Calendar, Tasks, and Contacts buttons** - allow you quick access to commonly used programs.

• **Navigation button** - functions like the four arrow keys and the Enter key on a keyboard. This multifunction button allows you to:
  
  - move through the program icons, folders, or files in a menu by scrolling up or down
  
  - launch a selected program, list folder contents, or open a file by pressing the center of the button

• **Speaker** - allows you to hear alarms and other sound outputs from the device.

---

**Left side features**

- **Charging status LED** - lights up orange when the battery is charging; lights up green when the battery is fully charged.

- **System indicator LED** - indicates the system status.

- **Infrared (IR) port** - allows you to copy or send data to another device with an IR port.
Top features

- **Headphone jack** - connects a headphone.
- **CF card slot** - accommodates a CompactFlash (CF) card. See list of supported CF cards on page iv.
- **Stylus** - used for tapping or writing on the LCD touch screen. Slide out the stylus from its compartment. Refer to the description of the stylus on the next page.

Bottom features

- **Cradle connector / Sync cable connector** - connects to the 26-pin female connector on the cradle. If you are not using the cradle, connect the 26-pin USB sync cable directly to this connector to synchronize your device with your computer.
- **Power connector** - connects the AC adapter cable. Use this connector if you wish to use AC power without the cradle.
Back features

- **Reset switch** - allows you to perform a soft reset in case of device malfunctions, or when an application hangs. Press the tip of the stylus on the switch to reset the system.

- **CF card slot cover** - protects the slot connector and the CF card.

The stylus

The stylus functions on a Pocket PC the same way a mouse functions on a standard PC. Use the stylus to tap or drag on the LCD touch screen to open programs or execute commands.

- **Tap.** Touch the screen once with the stylus to open programs and select options.

- **Drag.** Hold the stylus on the screen and drag across the screen to select text and images. Drag in a list to select multiple items.

- **Tap and hold.** Tap and hold the stylus on an item to see a list of actions available for that item. On the displayed pop-up menu, tap the action that you want to perform.
The cradle

The cradle has three connectors.

- **Device connector** - holds the device in place. This is a 26-pin connector that matches the connector on the bottom of the device.
- **USB connector** - synchronizes the device with your PC. 
  NOTE: The USB cable/connector is not detachable from the back of the cradle.
- **Power connector** - connects the bundled AC adapter. This connector is located at the back side of the cradle.
Setting up MyPal

Placing on the cradle

Position the device on the cradle as shown. Match the connectors and carefully insert the device until it fits in place.

Connecting the AC adapter

- Connect the AC adapter cable to the connector at the back of the cradle. Connect the power plug to a grounded wall socket. See Figure 1.
- If you are not using the cradle, connect the AC adapter cable directly to the power connector at the bottom of the device. Connect the power plug to a grounded wall socket. See Figure 2.
Installing and removing a CF card

The CF card slot on your device supports several types of CF card. Refer to the list of supported cards under “Optional Accessories” on page iv of this manual.

Install a CF card for additional storage, or if you wish to use the ASUS backup features.

To install a CF card:

1. Locate the card side with the 50-pin female connector and insert into the slot. The label side (usually the side with the card manufacturer’s name) face down, and the bar code/serial number side face up.

   ![Label side/Manufacturer’s name](image)

   ![Bar code/Serial number side](image)

   **NOTE**  A CF card fits only in one orientation, and slides smoothly into the slot if inserted correctly. DO NOT force the CF card into the slot!

2. Push the card all the way into the slot until it fits completely. If properly installed, the CF card edge aligns with the top edge of the device.
To remove a CF card:

1. Remove the CF card slot cover by pushing on the dent on the surface, and sliding the cover outward.

2. Slide out the CF card.

3. Replace the cover back into the slot.
Charging the battery

Your device includes a rechargeable Lithium Ion battery. You must charge the battery before using the device the first time. The battery starts charging as soon as you connect the AC adapter to a power source. Use the AC adapter to plug your device to a power source whenever possible, especially when you are using a modem or other peripherals, using the device backlight, connecting to a PC, or letting notification light flash for extended time periods.

To display the power status, tap Settings, System tab, and the Power icon.

Activating MyPal

It is important that you properly calibrate and activate your device before using it. This process ensures accurate positioning when entering text and selecting menus.

Follow these steps to calibrate and activate MyPal.

1. Press the power button.
2. Use the stylus to tap the LCD touch screen to start the calibration and activation.
3. At the prompt to align the screen, tap the center of the cross whenever the travelling cross stops on the screen. You may have to do this step several times to properly calibrate.
4. When done with the screen calibration, follow the screen instructions to complete the activation.
   • at the “Stylus” screen, tap Next to continue.
   • at the “Pop-up menus” screens, perform the indicated operations.
   • at the “Congratulations” screen, tap Next to continue.
   • at the “Location” screen, select your time zone and tap Next to continue.
   • at the “Completion” screen, tap the screen to continue.
5. When the Today screen appears, MyPal is ready to use. Proceed to the next section for information on the basic screens on your device.
Basic screens on MyPal

Today screen

Normally, the Today screen appears when you turn on your device for the first time each day.

NOTE When the device is already on and the screen displays another program, you can display the Today screen by tapping the icon. Then from the Navigation bar, tap Today.

As shown in the sample below, the Today screen lets you see at a glance the summary of the important information for the day.

From the Today screen, tap any of the listed items with the stylus to display the details. See “Chapter 2: Learn the basics” to learn how to modify the current tasks or activities, or to add new items or information.
Start menu

From the Start menu, you can select programs, settings, and Help topics. To display the Start menu, tap the icon from the top of the screen.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ActiveSync]</td>
<td>ActiveSync</td>
<td>Synchronize information between your device and your desktop computer.</td>
</tr>
<tr>
<td>![Calendar]</td>
<td>Calendar</td>
<td>Keep track of your appointments and create meeting requests.</td>
</tr>
<tr>
<td>![Contacts]</td>
<td>Contacts</td>
<td>Keep track of your friends and colleagues.</td>
</tr>
<tr>
<td>![Inbox]</td>
<td>Inbox</td>
<td>Send and receive e-mail messages.</td>
</tr>
<tr>
<td>![Internet Explorer]</td>
<td>Internet Explorer</td>
<td>Browse Web and WAP sites, and download new programs and files from the Internet.</td>
</tr>
<tr>
<td>![Notes]</td>
<td>Notes</td>
<td>Create handwritten or typed notes, drawings, and recordings.</td>
</tr>
<tr>
<td>![Tasks]</td>
<td>Tasks</td>
<td>Keep track of your tasks.</td>
</tr>
<tr>
<td>![Programs]</td>
<td>Programs</td>
<td>Tap to see additional programs installed in your device.</td>
</tr>
<tr>
<td>![Settings]</td>
<td>Settings</td>
<td>Tap to see items that you can customize or adjust to your preference.</td>
</tr>
<tr>
<td>![Find]</td>
<td>Find</td>
<td>Tap to find data in your device.</td>
</tr>
<tr>
<td>![Help]</td>
<td>Help</td>
<td>Tap to see the Help contents.</td>
</tr>
</tbody>
</table>
Command bar

At the bottom of the screen is the Command bar. You can use the menus and buttons on the Command bar to perform tasks in programs.

NOTE  
The menus and buttons vary depending on the programs you are using.

Pop-up menus

With the pop-up menus, you can easily choose an action for an item.

For example, you can use the pop-up menu in Tasks to delete, copy, or beam a task. The actions in the pop-up menus vary from program to program. To access a pop-up menu, tap and hold the stylus on the item that you wish to perform action on. When the menu appears, lift the stylus, and tap the action that you want to execute. To close the pop-up menu without performing an action, tap anywhere outside the menu.
The pop-up menus are also available in most other programs in your device. The pop-up menu items vary depending on the program or application. For example, the **File Explorer** pop-up menu includes more items than in **Tasks**.
Chapter 2

Learn the basics

♦ Entering information .............................................. 2-2
  Entering text using the Input Panel .................................. 2-2
  Writing on the screen ...................................................... 2-5
  Drawing on the screen ...................................................... 2-8
  Recording a message ...................................................... 2-9
  Using a preset message .................................................. 2-10

♦ Finding and organizing information ...................... 2-11
  Using the File Explorer .................................................. 2-12

♦ Customizing your device ........................................ 2-13
  Adjusting settings ......................................................... 2-13
  Selecting sounds and notifications ................................... 2-15
  Adding or removing programs ....................................... 2-15

♦ ASUS utilities ...................................................... 2-18
  ASUS SmartKeeper ....................................................... 2-18
  ASUS Backup ............................................................... 2-24
  ASUS Settings ............................................................... 2-30

♦ Bundled programs ............................................. 2-34
  ASUS Programs .......................................................... 2-34
  Games ................................................................. 2-34
  File Explorer .......................................................... 2-35
  Microsoft Reader ..................................................... 2-35
  Calculator ............................................................... 2-35
  MSN Messenger ....................................................... 2-36
  Pocket MSN .............................................................. 2-36
  Pocket Word .............................................................. 2-36
  Pocket Excel .............................................................. 2-37
  Pictures ................................................................. 2-37
  Terminal Services Client ........................................... 2-37
Entering information

You can enter information in your device in any of the following ways.

• Use the input panel to enter text using the soft keyboard or the Letter recorgnizer
• Write directly on the screen with the stylus
• Draw pictures on the screen
• Speak into the device microphone to record a message
• Use the Microsoft ActiveSync to synchronize or copy information from your desktop computer to your device

Entering text using the Input Panel

Use the Input Panel to enter information in any program on your device. You can either type using the soft keyboard or write using the Letter Recognizer, Block Recognizer, or Transcriber. In either case, the characters appear as typed text on the screen.

To show or hide the input panel, tap the Input Panel button. Tap the arrow next to the Input Panel button to see your options.

To type with the soft keyboard:

1. Tap the arrow next to the Input Panel button, then tap Keyboard.

   NOTE To demonstrate, open Notes.

2. Tap the keys with the stylus to enter information.
When you use the Input Panel and the soft keyboard, your device anticipates the word you are typing and displays it above the Input Panel. When you tap the displayed word, it is inserted into your text at the insertion point. The more you use your device, the more words it learns to anticipate.

![Image of Input Panel]

**NOTE**
To change options on word completion feature:

1. Tap 📑.
2. Tap Settings.
3. Tap Personal tab.
4. Tap Input.
5. Tap Word Completion tab.
6. Make your desired changes.

**To use Letter Recognizer:**

With the Letter Recognizer, you can write letters on the screen with the stylus as you would on paper.

1. Tap the arrow next to the Input Panel button, then tap **Letter Recognizer**.
2. Write a letter in the box.

When you write a letter, it is converted to a typed text that appears on the screen. For instructions and demonstration on using the Letter Recognizer, tap the question mark next to the writing area.
To use Block Recognizer:

With the Block Recognizer, you can input character strokes that are similar to those use on other devices.

1. Tap the arrow next to the Input Panel button, then tap **Block Recognizer**.
2. Write a letter in the box.
   When you write a letter, it is converted to a typed text that appears on the screen. For instructions and demonstration on using the Block Recognizer, tap the question mark next to the writing area.

To use Transcriber:

With Transcriber, you can use the stylus to write anywhere on the screen as you would on paper. Unlike Letter Recognizer and Block Recognizer, you can write a sentence or additional information. Pause after writing and let Transcriber convert the written characters to typed characters.

1. Tap the arrow next to the Input Panel button, then tap **Transcriber**.
2. Write anywhere on the screen.
   For instructions and demonstration on using Transcriber, with Transcriber open, tap the question mark in the lower right corner of the screen.

To edit typed text:

1. Select the text that you wish to edit using either one of the following:
   - drag the stylus over the text
   - tap twice to select a word
   - tap three times to select a paragraph
2. Tap Edit on the Command bar and select an action, or use one of the tools in the Input Panel to enter a new text.
Writing on the screen

In any program that accepts writing, such as the Notes program, and in the Notes tab in Calendar, Contacts, and Tasks, you can use the stylus to write directly on the screen. Write the way you do on paper. You can edit and format what you have written and convert the information to text at a later time.

To write on the screen:

1. Open the Notes program.
2. Tap the Pen button to switch to the writing mode. The screen displays blank space with lines to help you write.
3. Write your text.

Note: Some programs that accept writing may not have the Pen button. See the documentation for that program to find out how to switch to writing mode.
To edit your writing:

1. Tap and hold the stylus next to the text that you wish to select until the insertion point appears.
2. Without lifting, drag the stylus across the text to select it.
   If you accidentally write on the screen, tap **Tools**, then **Undo** and try again. You can also select text by tapping the **Pen** button to deselect it and then dragging the stylus across the screen.
3. Tap **Edit** on the Command bar and select an action, or use one of the tools in the Input Panel to enter a new text.

To convert writing to text:

- Tap **Tools**, then **Recognize**.

To select a zoom level:

- Tap **Tools**, then tap a zoom percentage from the options.

The writing is turned into text
If the conversion is incorrect, you can select different words from a list of alternates or return to the original writing.

1. Tap and hold the incorrect word.
2. When the pop-up menu appears, tap Alternates to display a list of alternate words for the selection.
3. Tap the word that you want to use, or tap the writing at the top of the menu to return to the original writing.

Tips for getting good writing recognition

- Write neatly.
- Write on the line and draw descenders below the line. Write the cross of the “t” and apostrophes below the top line so that they are not confused with the word above. Write periods and commas above the line.
- For better recognition, try increasing the zoom level to 300% using the Tools menu.
- Write the letters of a word closely and leave big gaps between words so that the device can easily tell where the words begin and end.
- Hyphenated words, foreign words that use special characters such as accents, and some punctuation cannot be converted.
- If you add writing to a word to change it (such as changing a “3” to an “8”) after you attempt to recognize the word, the writing you add will not be included if you attempt to recognize the writing again.
Drawing on the screen

You can draw on the screen in the same way that you write on the screen. The difference between writing and drawing on the screen is how you select items and how they can be edited. For example, selected drawings can be resized, while writing cannot.

To create a drawing:

1. Use the stylus to make a stroke three ruled lines high. A dotted box appears.
2. Make your drawing in or touching the drawing box and crossing three ruled lines. If the drawing does not cross three lines, it changes to writing.

| NOTE | To easily work on or view your drawing, change the zoom level by tapping Tools and selecting your desired zoom. |

To edit your drawing:

1. Tap and hold the stylus on the drawing until the selection handle appears. To select multiple drawings, deselect the Pen button then drag to select the drawings you want.
2. Tap and hold the selected drawing, then tap an editing command on the pop-up menu or tap a command on the Edit menu.
3. Resize the drawing by deselecting the Pen button (if selected) and dragging a selection handle to your desired size.
Recording a message

In any program where you can write or draw on the screen, you can also quickly capture thoughts, reminders, and phone numbers by recording a message. In Calendar, Tasks, and Contacts, you can include a recording in the Notes tab. In the Notes program, you can either create a stand-alone recording or include a recording in a written note. If you want to include the recording in a note, open the note first. In the Inbox program, you can add a recording to an e-mail message.

To create a recording:

1. Hold your device with the microphone near your mouth or other source of sound.
2. Press and hold the Record button on the device until you hear a beep.
3. While holding the Record button, make your recording.
4. To stop recording, release the Record button. You will hear two beeps. The new recording appears in the Note list or as an embedded icon.

   **NOTE** You can also make your recording using the buttons on the Recording toolbar.

5. To play the recording, tap it from the list, or if embedded in a note, tap the speaker icon.
To change the recording format:

1. In the note list, tap Tools then Options.
2. Tap the Global Input Options link.
3. Tap the Options tab.

   Mobile Voice is a 2.4KB audio codec. It is the recommended format because it provides good voice recording and less storage space.

   Pulse Code Modulation (PCM) provides slightly better sound quality but takes up 50 times more storage space than Mobile Voice recordings.

Using a preset message

When using Inbox or MSN Messenger, use My Text to quickly insert preset or frequently used messages into the text entry area. To insert a message, tap My Text and tap your desired message.

   NOTE You can add text after inserting a My Text message. However, you have to add it before sending the message.

To edit a preset message:

1. Tap Tools, then Edit My Text Messages.
2. Select a message and make your desired changes.
Finding and organizing information

The **Find** and **Help** features on your device help you quickly locate information.

**To find information:**

1. Tap 📱, then tap **Find**.
2. Enter the text that you want to find, select a data type, then tap **Go** to start the search. To quickly find information that is taking up space on your device, select **Larger than 64 KB** in Type.

![Image of Find feature]

**To use the Help feature:**

1. Tap 📱, then tap **Help**.
2. Tap a link to the topic that you wish to display.

![Image of Help feature]
Using the File Explorer

To use the File Explorer to find and organize files:

1. Tap ☐, then tap Programs.
2. In the Program screen, tap the File Explorer icon to display the files in your device.
Customizing your device

You can customize your device by adjusting the settings and installing additional software.

Adjusting settings

You can adjust the device settings to your preference.

To see the available options:

1. Tap 🔄 , then tap Settings to display the Settings screen.
2. Tap the Personal or System tab on the bottom of the screen.

You may want to adjust any one of the following items.

- **Clock.** Change the time or set alarms.
- **Menus.** Customize what appears on the 🛡️ menu, and enable a pop-up menu from the New button.
- **Owner information.** Enter your contact information.
- **Password.** Add security to your device.
- **Power.** Display the remaining battery power indicated by a bar chart.
- **Today.** Customize the look and information displayed on the Today screen.

**NOTE** Refer to the section “ASUS utilities” later in this chapter for details on the bundled ASUS programs.
To change the date and time settings:

1. Tap **Settings**, then the **System**.
2. Tap the **Clock** icon.
3. Make your desired settings.

To change the alarm settings:

1. Tap **Settings**, then the **System**.
2. Tap the **Clock** icon, then the **Alarm** tab.
3. Make your desired settings.
Selecting sounds and notifications

Your device can remind you of things you have to do in several ways. For example, if you have set up an appointment in Calendar, a task with a due date, or an alarm in Clock, you will be notified in any of the following ways.

- A message box appears on the screen
- A sound is played (you can select the type of sound)
- A light flashes on the device

To choose the reminder types and sounds:

1. Tap icon then tap Settings.
2. From the Settings screen, tap the Sounds and Notifications icon to display the Volume screen.
3. Adjust the items to your desired settings.
4. Tap the Notifications tab and set the event notification details.
Adding or removing programs

Programs added to your device at the factory are stored in ROM (Read-Only Memory). You cannot remove this software, and you will never accidentally lose ROM contents. ROM programs can be updated using installation programs with a *.xip extension. All other programs and data files added to your device after factory installation are stored in RAM (Random Access Memory).

You can install any program created for your device, as long as it has enough memory. The most popular place to find software for your device is on the Pocket PC web site (http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync:

NOTE You need to install the Microsoft ActiveSync on your desktop computer before you can synchronize and/or add programs to your device. Refer to “Chapter 3: Microsoft ActiveSync” for installation instructions.

1. Determine your device and processor type so that you know which version of the software to install. Tap ☁, then tap Settings. On the System tab, tap About. In the Version tab, take note of the information in Processor.

2. Download the program to your desktop computer (or insert the CD that contains the program into your desktop computer). You may see a single *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of files for different device types and processors. Be sure to select the program designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide special installation instructions.

4. Connect your device to your desktop computer.
5. Double-click the *.exe file.
   • If the file is an installer, the installation wizard begins. Follow the directions on the screen. Once the software is installed on your desktop computer, the installer automatically transfers the software to your device.
   • If the file is not an installer, you will see an error message stating that the program is valid but it is designed for a different type of computer. You need to move this file to your device. If you cannot find any installation instructions for the program in the Read Me file or documentation, use ActiveSync Explore to copy the program file to the Program Files folder on your device. For more information on copying files using ActiveSync, see ActiveSync Help.

6. When the installation is complete, tap Programs, and the program icon to switch to it.

To add a program directly from the Internet:

- **NOTE** You need to be connected to the Internet through an optional modem card or network card before you can add programs directly from the Internet.

1. Determine your device and processor type so that you know which version of the software to install. Tap Settings, then tap Settings. On the System tab, tap About. In the Version tab, take note of the information in Processor.

2. Download the program to your device straight from the Internet using the Pocket Internet Explorer. You may see a single *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of files for different device types and processors. Be sure to select the program designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide special installation instructions.

4. Tap the file, such as a *.xip or *.exe file. The installation wizard begins. Follow the directions on the screen.
To add a program to the Start menu:

1. Tap , tap Settings, tap Menus, tap the Start Menu tab, and tap the check box for the program. If you do not see the program on the list, you can either use File Explorer on the device to move the program to the Start Menu folder, or use ActiveSync on the desktop computer to create a shortcut to the program and place the shortcut in the Start Menu folder.

2. If you are using the File Explorer on the device:
   a. Tap , tap Programs, tap File Explorer, and locate the program (tap the folder list, labeled My Documents by default, then tap My Device to see a list of all the folders on the device).
   b. Tap and hold the program, then tap Cut on the pop-up menu. Open the Start Menu folder located in the Windows folder, tap and hold a blank area of the window, then tap Paste in the pop-up menu.
   c. The program now appears on the menu. For more information on using the File Explorer, see the section “Finding and organizing information” earlier in this chapter.

3. If you are using ActiveSync on the desktop computer:
   a. Use the Explorer in ActiveSync to explore your device files and locate the program. Right-click the program, then click Create Shortcut.
   b. Move the shortcut to the Start Menu folder in the Windows folder. The shortcut now appears on the menu. For more information, see ActiveSync Help.

To remove a program from the Start menu:

1. Tap , then tap Settings. On the System tab, tap Remove Programs.

2. If the program does not appear in the list of installed programs, use File Explorer on your device to locate the program, tap and hold the program, then tap Delete on the pop-up menu.
ASUS utilities

Besides the Microsoft program that allows you to back up data, your device also includes proprietary ASUS utilities. The ASUS utilities allow you to backup or restore data, and adjust settings to customize your device and maximize its use.

ASUS SmartKeeper

The ASUS SmartKeeper is an automatic backup feature that prompts you to backup the current system status in a CF memory card whenever the remaining battery power reaches a certain level. With the automatic option, the backup process is done whether the device is ON or OFF as long as a CF memory card is present in the slot.

Requirements for automatic backup

• SmartKeeper is enabled
• a CF memory card in the card slot (64MB free space recommended)
• the remaining battery power in the device reaches a low level

To enable automatic backup:

1. Tap 📱, then tap Settings.
2. Tap the System tab on the bottom of the Settings screen.
3. Tap the SmartKeeper icon to display the Automatic screen.
4. In the **Automatic** screen, check the **Automatic system backup** box to enable automatic backup. This box is checked by default.

When SmartKeeper is set to **Automatic**, make sure that a CF memory card (64MB free space recommended) is present in the CF card slot.

5. Tap **OK**.

---

**NOTE**

To verify if the CF memory card is usable for system backup, perform a Manual backup first. See the section “To use manual backup” on page 2-22.

---

**How the SmartKeeper automatic backup works**

SmartKeeper is capable of performing the automatic backup process whether your device is in use (ON) or in suspension (OFF).

**When the device is ON**

If a low battery status occurs while you are using the device, this message appears, **“Battery low! Back up the current system status?”**

*Backing up the “current system status” means that the entire system and all the data in the system main memory are saved as is to the ASUSBKUP.SAV file. For example, you are editing an Excel file when a battery low status occurs and you confirmed to back up. When you restore the system status from the ASUSBKUP.SAV file, you will see exactly the same screen, settings, and system configuration as earlier backed up.*
To back up the current system status:

1. Make sure that a CF memory card is present in the slot. If you tap Yes without the CF memory card, an error message appears.

2. Tap the Yes button on the screen message window to start the backup process. SmartKeeper saves your current system status to the file ASUSBKUP.SAV in the CF memory card. Tap No if you do not wish to back up the system status at this time.

3. A confirmation message appears when the backup process is complete.
When the device is OFF

If a low battery status occurs while the device is in standby or OFF, SmartKeeper wakes up the system to backup the system status.

To perform the backup process:

1. SmartKeeper checks if a CF memory card is ready in the slot.
2. If found, SmartKeeper backs up the current system status to ASUSBKUP.SAV file in the CF memory card. When the backup process is complete, the system automatically goes back to sleep (OFF).
   
   If a CF memory card is not ready in the slot, the device goes back to sleep without performing the backup process.

When you turn on the device, either one of the following messages is flashed on the screen.

<table>
<thead>
<tr>
<th>The system detected a battery power low status. The system status was automatically backed up to ASUSBKUP.SAV file in the CF memory card.</th>
<th>If automatic backup is successful</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system detected a battery power low status and tried to back up the system status at 2003/04/08, 10:21:27 AM. Backup failed! CF memory card not ready.</td>
<td>If automatic backup failed because a CF memory card in the slot may be defective and not accessible</td>
</tr>
<tr>
<td>The system detected a battery power low status and tried to back up the system status at 2003/04/08, 10:21:27 AM. Backup failed! Cannot access CF memory card.</td>
<td></td>
</tr>
<tr>
<td>The system detected a battery power low status and tried to back up the system status at 2003/04/08, 10:21:27 AM. Backup failed! Insufficient space in the CF memory card.</td>
<td></td>
</tr>
<tr>
<td>The system detected a battery power low status and tried to back up the system status at 2003/04/08, 10:21:27 AM. Backup failed! Insufficient space in the CF memory card.</td>
<td>If automatic backup failed because the available space in the CF memory card is not enough to back up the current system status</td>
</tr>
</tbody>
</table>
The system detected a battery power low status and tried to back up the system status at 2003/04/08, 10:21:27 AM. Backup failed! System error.

If automatic backup failed because a system error occurred.

To use manual backup:

1. Tap 📱, then tap Settings.
2. Tap the System tab on the bottom of the Settings screen.
3. Tap the SmartKeeper icon, then the Manual tab.
4. Tap the Back up system button to back up the current system status to ASUSBKUP.SAV file in the CF memory card.
5. A message appears to confirm that the backup process is complete.

To restore the system status:

1. Tap 📱, then tap Settings.
2. Tap the System tab on the bottom of the Settings screen.
3. Tap the SmartKeeper icon, then the Manual tab.
4. Tap the Restore system button to restore the saved system status from the ASUSBKUP.SAV file in the CF memory card.
SmartKeeper error messages

When backing up or restoring the system status, you may receive any one of the following error messages. The messages tell you the reason why the error occurred.

**Back up**

- **SmartKeeper**
  - Backup failed! CF memory card not ready.

- **SmartKeeper**
  - Backup failed! Cannot access CF memory card.

- **SmartKeeper**
  - Backup failed! Insufficient space in CF memory card.

- **SmartKeeper**
  - Backup failed! System error.

**Restore**

- **SmartKeeper**
  - Backup file ASUSBKUP.SAV not found in CF memory card!

- **SmartKeeper**
  - Backup file ASUSBKUP.SAV does not match this device!

- **SmartKeeper**
  - Backup file ASUSBKUP.SAV does not match the ROM version of this device!

- **SmartKeeper**
  - Backup file ASUSBKUP.SAV corrupted!

- **SmartKeeper**
  - System error!
ASUS Backup

The ASUS Backup utility lets you back up your system files and/or data contained in the main system memory. Unlike the ASUS SmartKeeper automatic backup feature that backs up the entire system status (system and data) into one backup file, this utility allows you to manually create separate backup files for your system files and data files. You may even categorize the data files and place into different folders.

To access the ASUS backup utility:

1. Tap 📌, then tap Programs.

   NOTE You need to insert an CF memory card into the CF slot on top of the device when backing up data. Otherwise, the message “CF memory card not ready!” appears.

2. Tap 📌, then tap 📌.
   A message appears asking you to stop other programs before running the backup utility.

3. Tap OK and stop all running programs.

To stop all running programs:

1. Tap 📌, then tap Settings.
2. Tap the System tab, then tap the Memory icon.
3. On the Memory screen, tap the Running Programs tab.
4. Tap the Stop All button, then tap OK.
To back up all data on your device:

1. Return to the ASUS programs screen and tap the **ASUS Backup** icon.
2. Tap the **Backup** tab on the ASUS Backup screen.
3. Tap **All Data** button to back up all data on your device.

4. In the Backup File screen:
   - specify a **file name** for the backup
   - specify the **folder** in which to store the backup file (optional)
   - select **CF Card** for the **location** of your backup file

5. Tap **OK** to start the backup process.

**NOTE**
Make sure that a CF card is installed in the slot before you continue with the backup process.

**NOTE**
See the online help on your device for online instructions to back up or restore data.
To back up only PIM data on your device:

1. On the ASUS Backup screen, tap **PIM Data** button to back up only the personal information management (PIM) data on your device.

2. Select **CF card** in the Storage Devices screen.
   Tapping **Cancel** returns you to the previous screen.

3. Tap the **Backup** tab.
4. Type a name for your backup file and the folder where you wish to place it. You may opt not to specify a folder.

5. Check the boxes opposite the items that you wish to back up, or tap **Select All** to select all listed items.

6. Tap **Start** to begin the backup process.

7. When the backup process is complete, the screen displays the message “Complete” and a list of all the backed up items.

8. Tap **OK**.
To restore all data from the CF memory card:

1. Tap , then tap Programs.

   **NOTE** You need to insert the CF memory card that contains your backup file into the CF slot on the device when restoring data. Otherwise, you will receive the message “No storage device are found!”

2. On the ASUS Programs screen
   Tap the **ASUS Backup** icon.
   When prompted, stop all running programs. See page 2-24 for instructions.

3. Tap the **Restore** tab on the ASUS Backup screen.

4. Tap **All Data**.

5. In the Backup File screen:
   • select the backup **file name**
     (tap the arrow to list down other backup files, if any)
   • select the **folder** that contains your backup file (optional)
   • select CF Card the **location**
     where you stored your backup

6. Tap **OK** to start the restore process.

7. When the restoration is done, a message appears prompting you to reset the device.

8. Tap **OK** to reset.
To restore PIM data from the CF memory card:

1. On the ASUS Backup screen, tap **PIM Data**.
2. When prompted, select CF card where you stored your backup file.
   Tapping Cancel returns you to the previous screen.
3. Tap the **Restore** tab.
4. Select the backup **file name** (tap the arrow to list down other backup files, if any).
5. Check the boxes opposite the items that you wish to restore, or tap **Select All** to select all listed items.
   If you checked the box **User Defined Folders**, tap **Define** to specify the folders that you wish to restore, then tap OK.
6. Tap **Start** to begin the restore process.
7. When the restoration is done, a message appears prompting you to reset the device.
8. Tap **OK** to reset.
ASUS Settings

To access the ASUS settings:

1. Tap 📘, then tap Settings.
2. Tap the System tab on the bottom of the Settings screen.
3. Tap the ASUS Settings icon to display the system information screen. This screen is displayed whenever you tap the Info tab.

**NOTE** Tap the left button of the four AP keys.

To change the Run Mode:

Tap the Mode tab to display the running mode of the CPU.

The **Turbo Mode** allows better CPU performance. In this mode, the CPU speed goes up to 400MHz. Set to this mode when playing games or playing video. However, setting to Turbo mode may reduce the battery life.

The **Standard Mode** allows for up to 300MHz CPU speed. Set to this mode when listening to MP3 audio files or for applications that do not require very fast CPU speed.

The **Power Saving Mode** sets the CPU to a fixed speed of 200MHz. Set to this mode when using text based applications such as Word, Excel, etc. This mode has a lower CPU performance but extends the battery life.

The **Automatic Mode** allows for 200MHz, 300MHz, or 400MHz CPU speed depending on the program that you are running.

Check the **Advanced Performance Enhancement** box to increase system performance.
To change the Display settings:

1. Tap the **Display** tab.
2. Set the degree of brightness while on battery power by **tapping the down arrow** and selecting a value, or by **dragging the slider** to the left or to the right until you achieve your desired brightness.
3. Follow step 2 to set the degree of brightness when using external power.

You may set the degree of brightness on battery power and on external power. Using a lower degree of brightness while on battery power substantially reduces battery power consumption.

To change the Audio settings:

Tap the **Audio** tab to adjust the volume, balance, treble, and bass settings.

Drag the slider to the left or to the right until you achieve your desired sound output.

Tap the **Default** button to restore the default audio settings.
To change the Microphone settings:

Tap the AGC tab to adjust the settings for the microphone sensitivity and automatic gain control (AGC).

The AGC features allows you to adjust the recording and environment noise level.

- The **MIC Sensitivity** controls the sound recording input. Setting the slider toward the “+” sign allows for a louder recording, but the environment noise level may be louder also.

- The **Gain Control** sets the sound recording output.

To change the Wakeup Sources:

Tap the **Wakeup tab** to select the source wakeup buttons.

Pressing any one of the checked buttons wakes up the device.

The program assigned to a specific button appears when you press that button.

Tap 📱, **Settings**, and **Buttons** for the button assignments. You may customize the button assignments.
To select Autorun Devices:

Tap the Autorun tab to select the source devices to execute the autorun program.
Bundled programs

Your device includes the most common Windows programs and more.

To access the bundled programs:

1. Tap , then tap Programs.
2. Tap any of the icons to launch a specific application program.

ASUS Programs

Tapping the ASUS Programs icon displays the ASUS Backup utility. Tap the ASUS Backup icon if you wish to use the utility. See section “ASUS Backup” on page 2-24 for details.

Games

Tap the Games icon to display the available games.
**Calculator**

Tap the Calculator icon to use the calculator.

**File Explorer**

Tap the File Explorer icon to access your files.

**Microsoft Reader**

Tap the Microsoft Reader icon to download and read online books.
**MSN Messenger**
Tap the MSN Messenger icon to use the service.

**Pocket MSN**
Tap the Pocket MSN icon to get connected to the Internet through the Pocket Internet Explorer.

**Pocket Word**
Tap the Pocket Word icon to create Pocket Word documents.
Pocket Excel
Tap the Pocket Excel icon to create spreadsheet documents.

Pictures
Tap the Pictures icon to view .jpg pictures stored on your device or on a storage card. Refer to the online help on your device for details on using this feature.

Terminal Services Client
Tap the Terminal Services Client icon to connect to a terminal server. Refer to the online help on your device for more information.
Chapter 3

Microsoft® ActiveSync®

♦ Introduction ........................................................... 3-2
  What is ActiveSync®? ......................................................... 3-2
♦ Installing ActiveSync® ...................................................... 3-3
  Installing ActiveSync® on your computer .................................. 3-3
♦ Synchronizing your device ............................................ 3-5
  Connecting your device to a computer ................................... 3-5
  Setting up a partnership .................................................... 3-6
  Checking synchronized information ...................................... 3-8
  Manually initiating synchronization ....................................... 3-9
  Synchronization options .................................................... 3-10
Introduction

What is ActiveSync®?

The Microsoft® ActiveSync® is one of the important bundled programs in MyPal. With ActiveSync, you can synchronize the information on your desktop computer with the information on your device. Synchronization compares the data on your device with your desktop computer and updates both computers with the most recent information.

For example:

• Keep Pocket Outlook data up-to-date by synchronizing your device with Microsoft Outlook data on your desktop computer.

• Synchronize Microsoft Word and Microsoft Excel files between your device and desktop computer. Your files are automatically converted to the correct format.

NOTE By default, ActiveSync does not automatically synchronize all types of information. Use the ActiveSync options to turn synchronization on or off for specific information types.

With ActiveSync, you can also:

• Back up and restore your device data

• Copy (rather than synchronize) files between your device and desktop computer

• Control when synchronization occurs by selecting a synchronization mode. For example, you can synchronize continually while connected to your desktop computer or only when you choose to synchronize.

• Select which information types are synchronized and control how much data is synchronized. For example, you can choose to synchronize your appointments of the past two weeks only, appointments older than two weeks are not synchronized.

For more information about using ActiveSync:

1. Start ActiveSync on your desktop computer.
2. From the Activesync menu bar, click Help then on Microsoft ActiveSync Help.
Installing ActiveSync®

The ActiveSync program is already installed on your device. To synchronize information on your device with your computer, you must also install ActiveSync on your computer. Install ActiveSync from the Companion CD that came with your product package.

NOTE Before starting the ActiveSync installation, make sure that you have Microsoft® Outlook® installed on your computer. If you do not have Outlook, install the Microsoft® Outlook® 2002 from the Companion CD. Even if you have Outlook 98 or Outlook 2000 installed, you are encouraged to update to Outlook 2002.

Installing ActiveSync® on your computer

To install ActiveSync on your computer:

1. Turn on your computer and monitor.

   NOTE Do not connect your device to your computer until you have finished installing ActiveSync.

2. Insert the Companion CD into the CD-ROM drive of your computer. The CD autoruns and displays the initial screen, then the Main Menu from which you can start the installation.

3. Click on Start Here from the Main Menu.
4. Read the **Overview** before installing ActiveSync 3.7 to make sure that you perform the installation sequence correctly.

5. If you have not installed Outlook, install it now. Click **Install Outlook 2002** and follow the screen instructions to complete the installation.

6. Click **Download Connection Wizard** and read the overview to see if you require the wizard. Follow the screen instructions to install the wizard on your computer. Return to the Main Menu when done.

7. Click **Install ActiveSync 3.7**, then click **Install**.

8. When prompted, select **Run this program from its current location** then click **OK**.

9. Follow the succeeding screen instructions. Click **Finish** to complete the installation.

10. Restart Windows when prompted, then proceed to the next section to connect your device to your computer and start synchronization.
Synchronizing your device

Connecting your device to a computer

To connect your device to your computer:

1. Place the device on the cradle.
2. Connect the AC adapter to the power connector on the cradle.
3. Connect the USB sync cable from the cradle to a USB port on your computer.

To connect your device to your computer without the cradle:

1. Connect the traveling USB sync cable with 26-pin connector to the 26-pin connector at the bottom of the device.
2. Connect the other end of the cable to a USB port on your computer.
Setting up a partnership

Immediately after you have completed the installation, the **New Partnership** wizard will start automatically to help you establish a partnership and customize your synchronization settings. At this point, you can decide exactly which types of information you would like to synchronize with your computer.

A **partnership** is a file that allows you to synchronize your device with your desktop computer. This file is stored on your desktop computer. An additional file that enables your desktop computer to recognize your device is stored on your device.

**To set up a partnership:**

1. When the **New Partnership** screen appears, select **Standard partnership** for the type of partnership to establish between your device and your computer. Click **Next**.

2. On the next screen, select **Synchronize with the desktop computer**. Click **Next**.

3. Select the type of information that you wish to synchronize. Click **Next**.
   OR
   If you wish to customize a synchronized item, highlight the item then click **Settings**.
On the Calendar Synchronization Settings window, for example, select from the options how you wish to synchronize the appointments on your device with your computer. Click OK.

4. Click Finish to complete setting a partnership.

Immediately after you set up a partnership, ActiveSync® starts automatically and initiates the first synchronization between your device and your computer.

Refer to the succeeding sections for more details on synchronization.
Checking synchronized information

After your first synchronization, take a look at Calendar, Contacts, and Tasks on your device. You will notice that the calendar information in Microsoft Outlook on your computer was copied to your device, and the information that you have on your device was copied to your computer.

NOTE Open Microsoft Outlook on your desktop computer to see the details of copied information from your device.
Manually initiating synchronization

Once you have set up ActiveSync and completed the first synchronization process, you can initiate synchronization from your device at any time.

To manually initiate synchronization:

1. Tap , then tap ActiveSync to display the ActiveSync screen.

2. To start synchronization, make a connection between your device and your computer, then tap Sync. To end synchronization, tap Stop.

For more information on synchronization:

   Tap while in the ActiveSync screen, then tap Help.
Synchronization options

The Microsoft ActiveSync program allows you to customize your synchronization settings at any time. You can select the items to synchronize, set the synchronization schedule, and specify the synchronization rules.

To display the synchronization options:

- From the ActiveSync window on your desktop computer, click on the Options icon, or
- From the menu bar, click on Tools, then Options.

To select items to synchronize:

1. Check the box opposite the item that you wish to synchronize.
2. Highlight a checked item then click on Settings to specify synchronization options for the item.
   
   For example, highlight Calendar then click on Settings to display the Calendar Synchronization Settings window. Customize the available settings, then click OK when done.

3. Do the same for the other checked items.

   **NOTE:** You cannot set the options for unchecked items.

4. Click OK when done.
To set synchronization schedule:
1. Click on the Schedule tab.
2. Select your desired synchronization schedule.
3. Click OK when done.

To specify synchronization rules:
1. Click on the Rules tab.
2. Select your desired settings from the available options.
3. Click OK when done.
Chapter 4

Microsoft® Pocket Outlook

♦ Introduction .............................................................. 4-2
♦ Calendar ................................................................ 4-2
  Creating appointments ................................................. 4-3
  Using the summary screen ......................................... 4-4
  Creating meeting requests ......................................... 4-4
♦ Contacts ................................................................ 4-5
  Creating contacts ....................................................... 4-6
  Using the summary screen ......................................... 4-6
  Finding a contact ....................................................... 4-7
♦ Tasks ..................................................................... 4-8
  Creating tasks .......................................................... 4-8
  Using the summary screen ......................................... 4-9
♦ Notes ...................................................................... 4-10
  Creating notes .......................................................... 4-11
♦ Inbox ..................................................................... 4-12
  Synchronizing e-mail messages ................................. 4-12
  Connecting directly to an e-mail server ..................... 4-13
  Using the message list .............................................. 4-14
  Composing messages .............................................. 4-16
  Managing e-mail messages and folders ..................... 4-17
Chapter 4

Introduction

Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use these programs individually or together. For example, e-mail address stored in Contacts can be used to address e-mail messages in Inbox.

Using ActiveSync®, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your desktop computer with your device. You can also synchronize this information directly with a Microsoft Exchange server. Each time you synchronize, ActiveSync compares the changes you mode on your device and desktop computer or server and updates both computers with the latest information. For information on using ActiveSync, see ActiveSync Help on your desktop computer.

You can switch to any of the Pocket Outlook programs by tapping 📅.

Calendar: Scheduling appointments and meetings

Use Calendar to schedule appointments, including meetings and other events. You can check your appointments in one of several views (Agenda, Day, Week, Month, and Year) and easily switch views using the View menu.

NOTE You can customize the Calendar display, such as changing the first day of the week, by tapping Options on the Tools menu.
Creating appointments

To create an appointment:

1. If you are in Day or Week view, tap your desired date for the appointment,
2. Tap New.
3. Using the input panel, enter a description and a location. Tap first to select the field.
4. If needed, tap the date and time to change them.
5. Enter other desired information. You will need to hide the input panel to see all available fields.
6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, see the “Notes: Capturing thoughts and ideas” later in this chapter.
7. When done, tap OK to return to Calendar.

NOTE If you select Remind me in an appointment, your device will remind you according to the options set in Settings, Personal tab, Sounds and Notifications.
Using the summary screen

When you tap an appointment in Calendar, a summary screen is displayed. To change the appointment, tap **Edit**.

Creating meeting requests

You can use Calendar to set up meetings with users of Outlook and Pocket Outlook. The meeting request will be created automatically and sent either when you synchronize Inbox or when you connect to your e-mail server.

**To create a meeting request:**

1. Tap Tools then Options to indicate how you want meeting requests sent
2. If you send and receive e-mail messages through ActiveSync, select **ActiveSync**.

**To schedule a meeting:**

1. Create an appointment.
2. In the appointment details, hide the input panel, then tap Attendees.
3. From the list of e-mail addresses you have entered in Contacts, select the meeting attendees.
   
   The meeting notice is created automatically and placed in the Outbox folder. For more information on sending and receiving meeting requests, see Calendar Help and Inbox Help on the device.
Contacts: Tracking friends and colleagues

Contacts maintains a list of your friends and colleagues so that you can easily find the information you look for, whether you are at home or on the road. Using the infrared port (IR) on the device, you can quickly share Contacts information with other device users.

Tap to select the category of contacts you want to display

Tap and enter part of a name to quickly find it on the list

Tap to display or edit the contact details

Tap to display additional phone numbers and email addresses

Tap an action for a selected contact

Tap to sort contacts by name or company

Tap to create a new contact

NOTE: To change the way information is displayed in the list, tap Tools then Options.
Creating contacts

To create a contact:

1. Tap ☐️, then tap Contacts.
2. Tap New to display a blank contact form.
3. Using the input panel, enter a name and other contact information. You will need to scroll down to see all available fields.
4. To assign the contact a category, scroll to and tap Categories, then select a category from the list. On the contact list, you can display the contacts by category.
5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, see “Notes: Capturing thoughts and ideas” later in this chapter.
6. Tap OK to return to the contact list when done.

Using the summary screen

Tapping a contact on the contact list displays a summary screen. To change the contact information, tap Edit.
Finding a contact

There are four ways to find a contact.

1. On the contact list, enter a contact name in the box under the navigation bar. To show all contacts again, clear text from the box or tap the button to the right of the box.

2. In the contact list, tap the category list (labeled All Contacts by default) and select the type of contact that you wish to display. To show all contacts again, select All Contacts. To view a contact not assigned to a category, select None.

3. To view the names fo companies your contacts work for, in the contact list, tap View > By Company. The number of contacts that work for that company will be displayed to the right of the company name.

4. Tap Find, enter the contact name, select Contacts for the type, and tap Go.
Tasks: Keeping a to do list

Use Tasks to keep track of what you have to do.

Creating tasks

To create a task:

1. Tap ☐ ☐, then tap Tasks.
2. Tap New to display a blank task form.
3. Using the input panel, enter a description.
4. Enter a start date and due date, or enter other information by tapping the field first. If the input panel is open, you will need to hide it to see all available fields.
5. To assign the task to a category, tap **Categories** and select a category from the list. On the task list, you can display tasks by category.

6. To add notes, tap the **Notes** tab. You can enter text, draw, or create a recording. For more information on creating notes, see “Notes: Capturing thoughts and ideas” later in this chapter.

7. Tap **OK** to return to the task list when done.

---

**TIP**
To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Tap **Tap here to add a new task** and enter your task information.

---

**Using the summary screen**

Tapping a task on the task list displays a summary screen. To change the task details, tap **Edit**.

---

**Task details**

Tap to show or hide the task details

**Notes/additional information on the task**

Tap to change the task details
Notes: Capturing thoughts and ideas

Quickly capture thoughts, reminders, ideas, and phone numbers with Notes. You can create a written note or a recording. You can also include a recording in a note. If a note is open when you create the recording, it will be included in the note as an icon. If the note is displayed, it will be created as a stand-alone recording.

You may change the default Notes options including the writing mode, template, file storage, and record button action.

To change the Notes options:

1. Tap , then tap Notes.
2. Tap Tools, then Options... to display the options screen.
3. Make your desired changes.
4. Click OK.
Creating notes

To create a note:

1. Tap , then tap Notes.
2. Tap New to display a blank note.
3. Create your note by writing, drawing, typing, or recording. For more information about using the input panel, writing and drawing on the screen, and creating recordings, see Chapter 2.
Inbox: Sending and receiving e-mail messages

Use Inbox to send and receive e-mail messages in one of these ways:

- Synchronize e-mail messages with Microsoft Exchange of or Microsoft Outlook on your desktop computer
- Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a network

Synchronizing e-mail messages

E-mail messages can be synchronized as part of the general synchronization process. You will need to enable Inbox synchronization in ActiveSync. For more information on enabling Inbox synchronization, see ActiveSync Help on your desktop computer.

During synchronization:

- Messages are copied from the mail folders of Exchange or Outlook on your desktop computer to the ActiveSync folder in Inbox on your device. By default, you will receive messages from the past three days only, the first 100 lines of each message, and file attachments of less than 100KB in size.
- E-mail messages in the Outbox folder on your device are transferred to Exchange or Outlook, then send from those programs.
- E-mail messages in subfolder must be selected in ActiveSync on your desktop computer in order to be transferred.

NOTE You can also synchronize e-mail messages with your desktop computer from a remote location. For more information, see Chapter 7.
Connecting directly to an e-mail server

In addition to synchronizing e-mail messages with your desktop computer, you can send and receive e-mail messages by connecting to an e-mail server using a modem or network card connected to your device. You need to set up a remote connection to a network or an ISP, and a connection to your e-mail server. For more information, see Chapter 7.

When you connect to the e-mail server, new messages are downloaded to the device Inbox folder, messages in the device Outbox folders are sent, and messages that have been deleted on the e-mail server are removed from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your desktop computer. When you delete a message on your device, it is also deleted from the e-mail server the next time you connect based on the settings you selected in ActiveSync.

You can work online or offline. When working online, you read and respond to messages while connected to the e-mail server. Messages are sent as soon as you tap Send, which saves space in your device.

When working offline, once you have downloaded new message headers or partial messages, you can disconnect from the e-mail server and decide which messages to download completely. The next time you connect, Inbox downloads the complete messages you have marked for retrieval and sends the messages you have composed.
Using the message list

The messages you receive are displayed in the message list. By default, the most recently received messages are displayed first in the list.

When you receive a message, tap it to open it. Unread messages are displayed in bold.
When you connect to your e-mail server or synchronize with your desktop computer, by default, you will receive messages from the last five days only, the first 100 lines of each new messages, and file attachments of less than 100KB in size. The original messages remain on the e-mail server or your desktop computer.

You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server connection. In the message list, tap and hold the message that you want to retrieve. On the pop-up menu, tap **Mark for Download**. The icons in the Inbox message list give you visual indications of message status.

You can specify your downloading preferences when you set up the service or select your synchronization options. You can change them at any time.

- Change options for Inbox synchronization using ActiveSync options. For more information, see ActiveSync Help on your desktop computer.

- Change options for direct e-mail server connections in Inbox on your device. Tap **Tools** then **Options**. On the Service tab, tap the service that you wish to change. Tap and hold the service and select **Delete** to remove a service.
Composing messages

To compose a message:

1. Tap New.
2. In the To field, enter an e-mail or SMS address of one or more recipients, separating them with a semicolon, or select a name from the Contacts list by tapping the Address Book button. All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.

3. Compose your message. To enter preset or frequently used messages, tap My Text and select a message.

4. Tap Send when you have finished the message. If you are working offline, the message is moved to the Outbox folder and will be sent the next time you connect.
Managing e-mail messages and folders

The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3, or IMAP4.

- If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be synchronized with your device. You can select to synchronize additional folders by designating them for ActiveSync. The folders you create and the messages you move will then be mirrored on the server. For example, if you move two messages from the Inbox folder to a folder named Family, and you have designated Family for synchronization, the server creates a copy of the Family folder and copies the messages into that folder. You can then read messages while away from your desktop computer.
- If you use SMS, messages are stored in the Inbox folder.
- If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the messages on the device and their copies on the mail server. The next time you connect, the mail server will see that the messages are missing from the device Inbox and delete them from the server. This prevents you from having duplicate copies of a message, but it also means that you will no longer have access to messages that you move to folders created from anywhere except the device.
- If you use IMAP4, the folders you create and the e-mail messages you move are mirrored on the server. Therefore, messages are available to you anytime you connect to your mail server, whether it is from your device or desktop computer. This synchronization of folders occurs whenever you connect to your mail server, create new folders, or rename/delete folders when connected.
Chapter 5

Companion programs

◆ Pocket Word .......................................................... 5-2
  Creating Pocket Word documents ............................. 5-3
  Saving Pocket Word documents ............................... 5-3
  Modes of entering information .............................. 5-5

◆ Pocket Excel ......................................................... 5-8
  Creating Pocket Excel documents ........................... 5-9
  Saving Pocket Excel documents .............................. 5-9
  Securing your Excel document .............................. 5-11
  Tips for working in Pocket Excel ......................... 5-12

◆ MSN Messenger .................................................. 5-13
  Setting up ............................................................ 5-13
  Working with contacts .......................................... 5-14
  Chatting with contacts ........................................ 5-15

◆ Windows Media Player for Pocket PC ............... 5-16

◆ Microsoft Reader .............................................. 5-17
  Getting books on your device ............................... 5-17
  Using the Library ................................................. 5-18
  Reading a book .................................................. 5-19
  Using Reader features ......................................... 5-20
  Removing a book ................................................ 5-20
The companion programs consist of Microsoft® Pocket Word, Microsoft® Pocket Excel, Microsoft® Money, Windows Media™ Player for Pocket PC, and Microsoft® Reader.

To switch to a companion program on your device, tap Programs on the menu, then tap the program that you wish to open.

**Pocket Word**

Pocket Word works with Microsoft Word on your desktop computer to give you easy access to copies of your documents. You can create new documents on your device, or you can copy documents from your desktop computer to your device. Synchronize documents between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports.

### Creating Pocket Word documents

**To create a new Word document:**

1. Tap , tap Programs, tap Pocket Word to launch the application.
   
   If you have existing Microsoft Word or Pocket Word documents in your device, a list of the documents appears.

   **NOTE** If you selected a template for new documents in the Options dialog box, that template appears with the appropriate text and formatting already provided.
2. Tap **New** to display a blank document.
3. Use any of the tools in the input panel to type your text.

**Saving Pocket Word documents**

**To save a Pocket Word document:**

When you have finished editing your document, tap **OK**.

The document is saved using the first line as file name if you did not specify a file name. For example, if your first line in the document has the words **Bits-n-Pieces**, these words appear in your Word documents list.
To specify save options:

1. With the document open, tap **Tools**.

2. From the pop-up menu, tap **Save Document As...** to display the **Save As** screen.

3. Change the file name by simply typing a new one in the **Name** field.

4. Tap the down arrow in the **Folder** field to select a folder where you wish to place the file.

5. Tap the down arrow in the **Type** field to select a file format.
   You can save the document you create or edit in a variety of formats:
   - Word (.doc)
   - Pocket Word (.psw)
   - Rich Text Format (.rtf)
   - Plain Text (.txt)

6. Tap the down arrow in the **Location** field to indicate the location of your saved file, either in the main memory of your device, or in a storage card, if available.

7. Tap **OK** when done.

**NOTE** If you do not wish to change the document format, but would like to change the file name, folder, and location of your document, simply tap **Edit** from the command bar, then tap **Rename/Move...** from the pop-up menu to make your changes.
Opening an existing Pocket Word document

Pocket Word contains a list of the files stored on your device. Tap a file in the list to open. To delete, make copies of, and send files, tap and hold a file in the list, then select the appropriate action on the pop-up menu.

NOTE
You can open only one Pocket Word document at a time; when you open a second document, you will be asked to save the first.
Modes of entering information

You can enter information in Pocket Word in one of four modes (typing, writing, drawing, or recording), which are displayed on the View menu. Each mode has its own toolbar that you can show or hide by tapping the Show/Hide Toolbar button on the command bar.

If you are opening a Word document created on a desktop computer, select Wrap to Window on the View menu so that you can see the entire document.

To change the zoom magnification:

1. Tap View, then tap Zoom.
2. Select your desired percentage.
   Select a higher percentage to enter text and lower one to see more of your document.

Typing Mode

Using the input panel, enter typed text into the document. For more information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. You can select text as you do in a Word document, using your stylus instead of the mouse to drag through the text you want to select. You can search a document to find text by tapping Edit and Find/Replace.
Writing mode

In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a guide, and the zoom magnification is greater than in typing mode to allow you to write more easily. For more information on writing and selecting writing, see Chapter 2.

NOTE

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and can be edited and manipulated as described in the next section.

Written words are converted to graphics (metafiles) when a Pocket Word document is converted to a Word document on your desktop computer.
**Drawing mode**

In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift your stylus off the screen after the first stroke, you will see a drawing box indicating the boundaries of the drawing. Every subsequent stroke within or touching the drawing box becomes part of the drawing. For more information on drawing and selecting drawings, see Chapter 2.

**Recording mode**

In recording mode, embed a recording into your document. Recordings are saved as .wav files. For more information on recording, see Chapter 2.
Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to copies of your workbooks. You can create new workbooks on your device, or you can copy workbooks from your desktop computer to your device. Synchronize workbooks between your desktop computer and your device so that you have the most up-to-date contents in both locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage logs.

Pocket Excel contains a list of the files stored on your device. Tap a file in the list to open. To delete, make copies of, and send files, tap and hold a file in the list, then select the appropriate action on the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and filtering. To display the toolbar, tap View, then tap Toolbar.

![Pocket Excel interface]

**NOTE** You can open only one Pocket Excel document at a time; when you open a second document, you will be asked to save the first.
Creating Pocket Excel documents

To create a new Excel document:

1. Tap , tap Programs, tap Pocket Excel.
2. Tap New to display a blank document.
   If you selected a template for new documents in the Options dialog box, that template appears with the appropriate text and formatting already provided.

Saving Pocket Excel documents

To save an Excel document:

When you have finished editing your document, tap OK.

By default, your document is saved as Book1 as file name. You can change the file name to one that is more descriptive of your document. See next section for saving options.
To specify save options:

1. With the document open, tap **Tools**.
2. From the pop-up menu, tap **Save Workbook As...** to display the **Save As** screen.
3. Change the file name by simply typing a new one in the **Name** field.
4. Tap the down arrow in the **Folder** field to select a folder where you wish to place the file.

5. Tap the down arrow in the **Type** field to select a file format.
   You can save the document you create or edit in a variety of formats:
   - Pocket Excel (.pxl)
   - Excel (.xls)
6. Tap the down arrow in the **Location** field to indicate the location of your saved file, either in the main memory of your device, or in a storage card, if available.
7. Tap **OK** when done.

**NOTE**
If you do not wish to save your workbook to a different format, but would like to change the file name, folder, and location of your document, simply tap **Edit** from the command bar, then tap **Rename/Move...** from the pop-up menu to make your changes.
Securing your Excel document

If your workbook contains sensitive or confidential information, you can protect it with a password.

To set a password for your workbook:

1. Open the workbook.
2. Tap Edit from the command bar, then tap Password... to display the password setting screen.
3. Type a password in the Password field.
4. Re-type the password in the Verify Password field.
5. Tap OK when done.

If you have set a password for your workbook, a password screen appears asking you to type your password whenever you try to open the workbook.

Type your password, then tap OK. If you type in a wrong password, a message appears telling you so.

NOTE DO NOT forget your password. You can not open your workbook unless you type in the correct password.
Tips for working in Pocket Excel

Take note of the following when working in large worksheets in Pocket Excel:

- **View in full-screen mode** to see as much of your worksheet as possible. Tap **View**, then tap **Full Screen**. To exit full-screen mode, tap **Restore**.
- **Show and hide window elements.** Tap **View**, then tap the elements to show or hide.
- **Freeze panes on a worksheet.** First select the cell where you want to freeze panes. Tap **View**, then tap **Freeze Panes**. You might want to freeze the top and leftmost panes in a worksheet to keep row and column labels visible as you scroll through a sheet.
- **Split panes** to view different areas of a large worksheet. Tap **View**, then tap **Split**. Drag the split bar to where you want it. To remove the split, tap **View**, then tap **Remove Split**.
- **Show and hide rows and columns.** To hide a row or column, select a cell in the row or column that you want to hide. Tap **Format**, then tap **Row** or **Column**, and tap **Hide**. To show a hidden row or column, tap **Tools**, then tap **Go To**, and type a reference that is in the hidden row or column. Tap **Format**, then tap **Row** or **Column**, and tap **Unhide**.

For more information on using Pocket Excel, tap , then tap **Help**.
MSN Messenger

MSN Messenger on your device is an instant messaging program that allows you to:

- See who is online
- Send and receive instant messages
- Have instant message conversations with groups of contacts

To use MSN Messenger:

You must have a Microsoft Passport™ account or a Microsoft Exchange e-mail account.

You must have a Passport to use the MSN Messenger Service. If you have a Hotmail® or MSN account, you already have a passport. Once you have obtained either a Microsoft Passport or Microsoft Exchange account, you are ready to set up your account.

Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com.

To launch MSN Messenger:

1. Tap , then tap Programs.
2. Tap MSN Messenger.
Signing up

To sign in to MSN Messenger service:

1. Tap **Tools** then tap **Sign in...** from the menu.
   OR
   Simply tap the **Tap here to sign in** area.

2. In the sign-in screen, enter your e-mail address and password. Tap **Sign In**.

---

**NOTE**  
If you already use MSN Messenger on your desktop computer, your contacts will show up on your device without being added again.
Working with contacts

The MSN Messenger window shows all of your messenger contacts at a glance, divided into Online and Not Online categories. From this view, while connected, you can chat, send an e-mail, block the contact from chatting with you, or delete contacts from your list using the pop-up menu.

To see others online without being seen, tap **My Status** in the **Tools** menu and select **Appear Offline**.

If you block a contact, you will appear offline but will remain on the blocked contact’s list. To unblock a contact, tap and hold the contact, then tap **Unblock** on the pop-up menu.
Chatting with contacts

Tap a contact name to open a chat window. Enter your message in the text entry area at the bottom of the screen, or tap My Text to enter a preset message, then tap Send. To invite another contact to a multi-user chat, tap Invite in the Tools menu, then tap the contact that you want to invite.

NOTE To switch back to the main window without closing a chat, tap the Contacts button. To go back to your chat window, tap Chats and select the person whom you were chatting with.

To know if the contact you are chatting with is responding, look for the message under the text entry area. For more information on using MSN Messenger, tap Help, then tap Help.
Use Microsoft® Windows Media Player for Pocket PC to play digital audio and video files that are stored on your device or on a network. To switch to Windows Media Player for Pocket PC, tap , tap Programs, then tap Windows Media.

Use Microsoft Windows Media Player on your desktop computer to copy digital audio and video to your Pocket PC. You can play Windows Media and MP3 files on your Pocket PC.

For more information on using Windows Media Player for Pocket PC, tap , then tap Help.
Microsoft Reader

Use Microsoft Reader to read eBooks on your device. Download books to your desktop computer from your favorite eBook web site. Then, use ActiveSync to copy the book files to your activated device. The books appear in the Reader Library.

Each book consists of a cover page, an optional table of contents, and the pages of the book. You can:

- Page through the book using the Up/Down control on your device, or by tapping the page number on each page.
- Annotate the book with highlighting, bookmarks, notes, and drawings.
- Search for text and look up definitions for words.

The Guidebook contains all the information that you need to use the software. To open the Guidebook, tap Help on the Reader command bar. Or, on a book page, tap and hold on the book title, then tap Help on the pop-up menu.

To launch Microsoft Reader:

1. Tap , then tap Programs.
2. Tap Microsoft Reader.
Getting books on your device

You can download book files from the Web. Just visit your favorite eBook retailer and follow the instructions to download the book files.

Sample books and a dictionary ar also included in the MSReader folder in the Extras folder on the Pocket PC Companion CD.

Use ActiveSync to download the files from your desktop computer to your activated device as described in the Read Me file in the MSReader folder.

Using the Library

The Library is your Reader home page. It displays a list of all books stored on your device or storage card.

To open the library:

1. On the Reader command bar, tap Library.
2. On a book page, tap the book title, then tap Library on the pop-up menu.
   
   To open a book, tap its title in the Library list.
Reading a book

Each book consists of a cover page, and optional table of contents, and the pages of the book. Navigation options are listed in the bottom portion of the cover page.

The first time you open a book, you will probably want to go to the first page or to the table of contents, if there is one. Subsequently, whenever you open a book, you will be automatically taken to the last page read.

In addition to the text, each book page includes a page number and the book title.

You can also page through a book using the Up/Down control on your device.
Using Reader features

Reading a book electronically gives you several options not available with paper books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the pop-up menu, as described below.

- **Search for Text.** Find text in a book by tapping Find on the pop-up menu. Enter the word you want to search for, and tap the desired Find option. Reader highlights found text on the page. To close Find, tap outside the box. To return to your original page, tap the title then tap Return on the pop-up menu.

- **Copy Text.** You can copy text from books that support this feature into any program that accepts text. On a book page, select the text that you want to copy. Then, tap Copy Text on the pop-up menu. The text can be pasted into the program of your choice.

- **Bookmarks.** When you add a bookmark to a book, a color-coded bookmark icon appears on the right margin. You can add multiple bookmarks to a book. Then, from anywhere in the book, tap the bookmark icon to go to the bookmarked page.

- **Highlights.** When you highlight text, it appears with a colored background.

- **Notes.** When you attach a note to text, you enter the text in a note pad that appears on top of the book page. A Note icon appears on the left margin. To show or hide the note, tap the icon.

- **Drawings.** When you add a drawing, a Drawing icon appears on the bottom-left corner of the page, and drawing tools appear across the bottom of the page. Draw by dragging your stylus.

**NOTE** To see a list of a book’s annotations, including bookmarks, highlights, text notes, and drawings, tap Annotations Index on the book’s cover page. You can tap an entry in the list to go to the annotated page.

Removing a book

When you finish reading a book, you can delete it to conserve space on your device. If a copy of the book is stored on your desktop computer, you can download it again at any time.

To remove a book from your device, tap and hold the title in the Library list, then tap Delete on the pop-up menu.
Chapter 6

Pocket Internet Explorer

♦ Introduction ........................................................... 6-2

♦ Using Pocket Internet Explorer ........................... 6-2
  Changing View settings ...................................................... 6-3
  Browsing the Internet .......................................................... 6-3

♦ AvantGo Channels ................................................ 6-4

♦ Mobile Favorites folder ........................................ 6-5
  Favorite links ...................................................................... 6-5
  Mobile Favorites ................................................................. 6-5
  Viewing mobile favorites and channels .............................. 6-7
  Adding/Deleting mobile favorites and folders ..................... 6-8
Introduction

Use Microsoft Pocket Internet Explorer to view Web or WAP pages in any of these ways.

- During synchronization with your desktop computer, download your favorite links and mobile favorites that are stored in the Mobile Favorites sub-folder in the Internet Explorer on the desktop computer.
- Connect to an Internet service provider (ISP) or network and browse the Web. To do this, you need to create the connection first. See Chapter 7 for information on creating a connection.

When connected to an ISP or network, you can also download files and programs from the Internet or intranet.

Using Pocket Internet Explorer

You can use Pocket Internet Explorer to browse mobile favorites and channels that have been downloaded to your device without connecting to the Internet. You can also connect to the Internet through an ISP or a network connection to browse the Web.

To launch Pocket Internet Explorer:

1. Tap , then Internet Explorer to display the Pocket MSN services.
2. Tap the **Home** button to display the Pocket Internet Explorer welcome screen with links to some useful Web sites.

3. Tap any of the Web site buttons to go to a specific site.

### Changing View settings

**To change View settings:**

1. Tap **View** to display a pop-up menu.
2. Tap **Fit to Screen** to see all the screen items at the same time.
3. Tap **Address Bar** to display the Web site address bar.
4. Tap and hold **Text Size** to display another pop-up menu with a text size selection. Select your desired text size for the screen.

### Browsing the Internet

**To browse the Internet:**

1. Set up a connection to your ISP or corporate network using **Connections**. See Chapter 7 for details.
2. Do one of the following to connect and start browsing:
   - Tap the **Favorites** button, then tap the favorite that you wish to view.
   - Tap **View**, then **Address Bar**. Enter the Web address that you want to visit then tap **Go**.
AvantGo Channels

AvantGo is a free interactive service that gives you access to personalized content and thousands of popular Web sites. You subscribe to AvantGo channels directly from your device. Then, synchronize your device and desktop computer, or connect to the Internet to download the content.

For more information, visit the AvantGo web site at http://avantgo.com/

To activate AvantGo:

1. In the ActiveSync window on your desktop computer, click Options.
2. In the Sync Options tab, check the box beside the AvantGo item. Click OK.
   
   ActiveSync automatically updates the settings and synchronizes with your device.

   NOTE Make sure that your computer is connected to the Internet.

3. When synchronization is complete, the AvantGo home page appears on your device.

To launch AvantGo:

1. In Pocket Internet Explorer on your device, tap the Favorites button to display your list of favorites.
2. Tap the AvantGo Channels link to go directly to the AvantGo home page and see a few of the most popular channels.

To add or remove channels:

Tap the Add or Remove link.
The Mobile Favorites folder

Only items stored in the Mobile Favorites sub-folder in the Favorites folder in the Internet Explorer on your desktop computer will be synchronized with your device. This folder was created automatically when you installed ActiveSync.

Favorite links

During synchronization, the list of favorite links in the Mobile Favorites folder on your desktop computer is synchronized with Pocket Internet Explorer on your device. Both computers are updated with changes made to either list each time you synchronize. Unless you mark the favorite link as a mobile favorite, only the link will be downloaded to your device, and you will need to connect to your ISP or network to view the content. For more information on synchronization, see ActiveSync Help on the desktop computer.

Mobile Favorites

If you are using Microsoft Internet Explorer 5.0 or later on your desktop computer, you can download mobile favorites to your device. Synchronizing mobile favorites downloads Web content to your device so that you can view pages while you are disconnected from your ISP and desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites quickly.
To create a mobile favorite:

1. In Internet Explorer on your desktop computer, click **Tools** then **Create Mobile Favorite**.

2. To change the link name, enter a new name in the **Name** box.

3. Select your desired update schedule in **Update**. This is optional.

4. Click **OK**. Internet Explorer downloads the latest version of the page to your desktop computer.

5. If you want to download the pages that are linked to the mobile favorite you just created, in Internet Explorer on the desktop computer, right-click the mobile favorite, then click **Properties**. In the **Download** tab, specify the number of links deep you want to download. To conserve device memory, go only one level deep.

6. Synchronize your device and your desktop computer. Mobile favorites that are stored in the Mobile Favorites in Internet Explorer are downloaded to your device.

**NOTE**

If you did not specify an update schedule in step 3, you will need to manually download content to keep the information updated on your desktop computer and device. Before synchronizing with your device, in Internet Explorer on your desktop computer, click **Tools** then **Synchronize**. You will see the last time content was downloaded to the desktop computer, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet Explorer on your desktop computer, click **View**, **Toolbars**, and **Customize**.
Saving device memory
Mobile favorites take up storage memory on your device. To minimize the amount of memory used:

- In the settings for the Favorites information type in ActiveSync options, turn off pictures and sounds, or stop some mobile favorites from being downloaded to the device. For more information, see ActiveSync Help.
- Limit the number of downloaded linked pages. In Internet Explorer on your desktop computer, right-click the mobile favorite you want to change, then click Properties. In the Download tab, specify 0 or 1 for the number of linked pages you want to download.

Viewing mobile favorites and channels

To view mobile favorites and channels:

1. Tap to display your list of favorites.

2. Tap a Favorites page that you wish to view.
   You will see the page that was downloaded the last time you synchronized with your desktop computer. If the page is not on your device, the favorite is dimmed. You need to synchronize with your desktop computer again to download the page to your device, or connect to the Internet to view the page.
Adding/Deleting mobile favorites and folders

To add a favorite:

1. Tap ⭐ to display your list of favorites.
2. Tap the **Add/Delete** button to display the **Favorites** screen.
3. Tap the **Add**... button to show the **Add Favorite** screen.
4. Type a name for the favorite that you wish to add in the **Name** field.
5. Type in the URL address in the **Address (URL)** field.
6. Select a folder to place the favorite from the **Create in:** box.
7. Tap **Add** to return to the Favorites screen, which now shows the favorite that you added.

To delete a favorite:

1. Tap ⭐ to display your list of favorites.
2. Tap the **Add/Delete** button to display the **Favorites** screen.
3. Select the favorite that you wish to delete, then tap **Delete**.
4. When prompted to permanently delete the favorite, tap **Yes**.
To add a folder:

1. Tap ⭐️ to display your list of favorites.
2. Tap the Add/Delete button to display the Favorites screen.
3. Tap the New Folder button.
4. Type a name for the folder that you wish to create.
5. Tap Add to return to the Favorites screen, which now shows the folder that you added.

To delete a folder:

1. Tap ⭐️ to display your list of favorites.
2. Tap the Add/Delete button to display the Favorites screen.
3. Select the folder that you wish to delete, then tap Delete.
4. When prompted to permanently delete the folder, tap Yes.
Chapter 7

Get connected

◆ Introduction ................................................................. 7-2
◆ Connect to the Internet ........................................ 7-2
◆ Connect to Work ................................................... 7-3
◆ Set up connections .................................................. 7-3
  Modem connections ................................................................. 7-3
  VPN server connections .......................................................... 7-4
  Proxy server settings ............................................................... 7-4
  Network card settings ........................................................... 7-5
  Wireless network connections ................................................. 7-6
  Enter settings information .................................................... 7-6
  Configure authentication settings ........................................... 7-7
  Change connection settings name ........................................ 7-7
◆ End a connection .................................................. 7-8
◆ Set up a WAP gateway ........................................... 7-8
◆ Use dialing rules ................................................... 7-9
◆ Infrared (IR) connection ......................................... 7-10
  Sending information ............................................................ 7-11
  Receiving information .......................................................... 7-11
◆ Bluetooth connection ........................................... 7-12
  Bluetooth modes ................................................................. 7-12
  Bluetooth settings ............................................................... 7-13
  Making your device discoverable ........................................... 7-13
  Beaming information with Bluetooth ........................................ 7-14
  Receiving a Bluetooth beam ............................................. 7-14
Introduction

You can set up connections to the Internet and corporate network at work in order to do such activities as browse the Internet or intranet, send and receive e-mail and instant messages, and synchronize information using ActiveSync.

Connections can be made using a **modem**, **wireless network**, or **network (Ethernet) card**. A modem connection can be used to set up connections with an external modem, or through your mobile phone network using a cellular line.

Your device has two groups of connection settings: **My ISP** and **My Work Network**. My ISP settings are used to connect to the Internet, and My Work Network settings can be used to connect to any private network, such as a corporate network you use at work. Simply fill in the settings and get ready to start connecting. For more information, see the sections “Connect to the Internet” or “Connect to Work.”

You may also establish connection to another device with infrared (IR) or Bluetooth features. For more information, see sections “Infrared (IR) connection” or “Bluetooth connection.”

Connect to the Internet

To connect to the Internet:

1. Obtain the following information from your ISP: **ISP server phone number**, **user name**, and **password**.
2. Tap > **Settings** > **Connections tab** > **Connections**.
3. In My ISP, tap **Add a new modem connection**.
4. Create a modem connection. For more information, see section “Set up modem connections.”
5. To start the connection, begin using the desired program. For example, switch to **Pocket Internet Explorer** and browse a **Web page**. Your device automatically connects.

**NOTE** To set up a network card or wireless network connection to your ISP, add a new connection under **My Work Network**.
Connect to Work

1. Obtain the following information from your network administrator: server phone number, user name, and password.

2. Tap 📱 > Settings > Connections tab > Connections.

3. In My Work Network, set up either a modem, network card, wireless network, or VPN server connection. Refer to the section “Set up connections” for the procedure.

4. To start the connection, start using a desired program. For example, switch to Pocket Internet Explorer and browse to a Web page. Your device automatically starts connecting.

Set up connections

Modem connections

To set up a modem connection:

Obtain the following information from your ISP or network administrator: telephone number, user name, password, domain name, and TCP/IP settings.

If your device does not have access to a mobile phone network, insert a modem card.

1. Tap 📱 > Settings > Connections tab > Connections.

2. To create a new connection, in either My ISP or My Work Network, tap Add a new modem connection, then follow the instructions in the New Connection wizard.

3. To view additional information for any screen in the wizard or while changing settings, tap 🔍.

**NOTE**

To change modem connection settings in either My ISP or My Work Network, tap Manage existing connections. Select the desired modem connection, tap Settings, and follow the instructions on the screen.
VPN server connections

A VPN connection helps you to securely connect to servers, such as a corporate network, via the Internet. Ask your network administrator for your user name, password, domain name, TCP/IP settings, and host name or IP address of the VPN server.

To set up a VPN server connection:

1. Tap > Settings > Connections tab > Connections.
2. To create a new VPN server connection, in My Work Network, tap Add a new VPN server connection, then follow the screen instructions.
3. To view additional information for any screen in the wizard or while changing settings, tap .

NOTE To change existing settings, in My Work Network, tap Manage existing connections > VPN tab. Select your desired VPN connection, tap Settings, then follow the instructions on the screen.

Proxy server settings

If you are connected to your ISP or private network during synchronization, your mobile device should download the proper proxy settings from your PC. If these settings are not on your PC or need to be changed, ask your ISP or network administrator for the proxy server name, server type, port, type of Socks protocol used, and your user name and password.

To change proxy server settings:

1. Tap > Settings > Connections tab.
2. To create a new connection, in My Work Network, tap Add a new proxy server.
3. To change proxy server settings, in My Work Network, tap Edit my proxy server. Select the desired proxy server, and tap Settings.
4. Select This network connects to the Internet and This network uses a proxy server to connect to the Internet.
5. In the Proxy server box, enter the proxy server name.
6. To change such settings as port number or proxy server type, tap Advanced and change desired settings.
Network card connections

Use a network (Ethernet) card to connect directly to a network. Once connected, you can view the Internet or intranet, or download e-mail. You do not need to create a new connection on your device. For more information, see your network administrator. Make sure to purchase and configure a network card that is compatible with your device.

To set up a network card:

1. Obtain the following information from your network administrator: user name, password, and domain name.
2. Insert the network card into your device.
3. The first time you insert the card, Network Settings appears automatically so that you can configure the network card. If it does not appear, or to change settings later, tap Settings > Connections tab > Connections > Advanced tab > Network Card.
4. If you need to enter specific server information, tap the appropriate adapter, and then tap Properties. Most networks use DHCP, so you should not have to change these settings unless your network administrator instructs you to do so.
5. If necessary, connect the network card to the network by using a network cable. For information, refer to the documentation that came with your network card.
6. To start a connection, insert the network card, and begin using a desired program. For example, switch to Pocket Internet Explorer and browse a Web page. Your device automatically starts connecting. If you use your network card with two networks, such as a private network at work and one at home for the Internet, you need to change the network to which the network card connects.

NOTE You may need proxy server and VPN connection settings. For more information, see your network administrator.
Wireless network connections

Networks that you have already configured are preferred networks and are listed in Wireless networks. You can select to connect to only preferred networks or have your device search for and connect to any available network whether it is preferred or not.

To set up a wireless network:

1. Tap > Settings > Connections tab > Connections > Network Card > Wireless tab.
2. To change network settings, in Wireless networks, tap a network. If you do not see a desired network, tap Add new and follow the instructions on the screen.
3. From Networks to access, select All available, Only access points, or Only computer-to-computer depending on the type of network(s) you connect to.
4. To connect only to networks you have already configured, clear Automatically connect to non-preferred networks.

NOTE If you select to automatically connect to non-preferred networks, your device detects any new networks and provide you the opportunity to configure them.

Enter settings information

A wireless network can be added either when the network is detected, or manually by entering settings information.

To enter new settings:

1. To manually enter information, tap > Settings > Connections tab > Connections > Network Card > Wireless tab. Then, tap Add new. If the network was detected, step one is not necessary.
2. In the General tab, enter a network name. If the network was detected, the network name is automatically entered and can't be changed.
3. From Connects to, select what your network connects to, Work or the Internet.
4. To connect to an ad-hoc connection, select This is a device-to-computer (ad-hoc) connection.
Configure authentication settings

A wireless network can be added either when the network is detected, or manually by entering settings information. To determine if authentication information is needed, see your network administrator.

To configure authentication settings:

1. To manually enter information, tap > Settings > Connections tab > Connections > Network Card > Wireless tab.
2. Tap Add new. If the network was detected, step one and two are not necessary.
3. To use data encryption, tap Data encryption (WEP enabled).
4. To use Shared Key authentication, tap Network Authentication (shared mode). You need a network key.
5. To automatically use a network key, tap The key is provided for me automatically. Otherwise, enter the network key.
6. For increased security, select Use IEEE 802.1x network access control, then select the appropriate EAP type.

Change connection settings name

Your mobile device is already set up with two sets of connection settings: My ISP and My Work Network. You can change the name of these settings to something more familiar. For example, if you put all of your corporate settings under My Work Network, you can change the name from My Work Network to your company name.

To change a connection name:

1. Tap > Settings > Connections tab > Connections.
2. Under My ISP or My Work Network, tap Manage existing connections.
3. Tap the General tab.
4. Enter a name for the settings.
End a connection

- When connected via modem or VPN, tap \( \leftrightarrow \) on the navigation bar, then tap Disconnect.
- When connected via cable or cradle, detach your device from the cable or cradle.
- When connected via Infrared, move the device away from the other computer or device.
- When connected via a network (Ethernet) card, remove the card from your device.
- When connected via a wireless network, switch off the connection.

Set up a WAP gateway

To access WAP sites through Pocket Internet Explorer, configure your device to use a WAP gateway. Use the following steps to create a new set of connections to the Internet with WAP gateway settings.

**NOTE** Some device models do not support the WAP sites viewing feature.

1. Get the following information from your ISP: **ISP server phone number**, **user name**, and **password**. Also, contact your mobile phone service provider and ask for your WAP gateway server name and port number.

2. Tap \( \equiv \) > **Settings** > **Connections tab** > **Connections** > **Tasks tab**.

3. Tap Edit my proxy server. If a proxy server has not been set up, tap Set up my proxy server.

4. In **Programs that automatically connect to the Internet should connect using**, tap **New** and enter a name for the ISP connection.

5. On the **Proxy Settings** tab, select **This network connects to the Internet** and **This network uses a proxy server to connect to the Internet**.

6. If necessary, in the **Proxy server** box, enter the proxy server name.

7. Tap **Advanced**.

8. In the **WAP** box, enter the **WAP gateway server name**. Under Port, enter the port number. The most common WAP port number is 9201.
9. Create a modem connection. See section “Set up connections.”
    If necessary, set dialing rules. See section “Use dialing rules.”

10. If your device does not have a connection to a mobile phone network,
    insert a modem card.

Use dialing rules

Additional numbers may need to be dialed depending on your given
location when connecting. For example, if you want to dial from work, a 9
prefix must often be dialed, or an area code is needed.

To avoid creating a new modem connection for each situation, set dialing
rules for the locations from which you connect often. Three dialing
locations, Home, Mobile, and Work, have been created for you, and you
can create more. If a connection cannot be made, your device gives you
an opportunity to change the dialing location.

1. Tap 📱 > Settings > Connections tab > Connections > Advanced
   tab.
2. Tap Select Location.
3. Tap Use dialing rules.
4. Select a location.
   • Home - Dials the number as a local call without a 9 prefix.
   • Work - Dials the number as local call with the 9 prefix.

   **NOTE** To create a new location, tap New and follow the directions
   on the screen. To view additional information at any time, tap.
Infrared (IR) connection

By default, your device detects incoming infrared (IR) beams and prompts you to accept them. If you do not want your device to detect or receive beams, clear the **Receive all incoming beams** check box.

To set the Beam options:

1. Tap 📱, then **Settings**.
2. Tap the **Connections** tab.
3. Tap the **Beam** icon to display the **Settings** screen.

4. Make your desired change and tap **OK**.
5. To receive an infrared beam from this screen, tap the link at the bottom. Your device automatically looks for another device using infrared.
Sending information

To send information:

1. Switch to the program where you created the item that you want to send, and locate that item in the list.
2. Align the IR ports so that they are unobstructed and within a close range.
3. Tap and hold the item, then tap Beam File... on the pop-up menu.

NOTE

You can also send items, but not folders, from File Explorer. Tap and hold the item that you want to send, then tap Beam File on the pop-up menu.

Receiving information

To receive information:

1. Align the IR ports so that they are unobstructed and within a close range.
2. Have the owner of the other device send the information to you. Your device automatically receive the information.
Bluetooth connection

Bluetooth is a short-range wireless communications technology. Devices with Bluetooth capabilities can exchange information over a distance of about 10 meters (30 feet) without requiring a physical connection.

Unlike infrared, you don't need to line up the devices to beam information with Bluetooth. The devices only need to be within a range of about 10 meters. You can even beam information to a device in a different room, as long as it's within range.

Microsoft Pocket PC 2003 software allows you to use Bluetooth in the following ways:

- Beam information, such as files, appointments, tasks, and contact cards, between devices that have Bluetooth capabilities. For example, if you and a co-worker each have a device with Bluetooth, you can beam items between your devices, such as files, contact cards, appointments, tasks, and so forth.
- Create a dial-up modem connection between your device and a Bluetooth phone. You can then use the Bluetooth phone as a modem.

Your device might include additional Bluetooth features. For more information, see the documentation included with your device.

Bluetooth modes

Bluetooth operates in three different modes:

- **On.** The Bluetooth radio is turned on and you can use Bluetooth features.
- **Off.** The Bluetooth radio is turned off. In this mode, you can neither send nor receive information by using Bluetooth. You might want to turn the radio off at times in order to conserve battery power, or in situations where radio use is prohibited, such as on airplanes and in hospitals.
- **Discoverable.** The Bluetooth radio is turned on, and all of the other Bluetooth devices within range (about 10 meters) can detect your device and attempt to beam information to it, establish a bond, or use a Bluetooth service. In this mode, other devices can detect your device whether or not a bond has been created; however, in order to receive a beam from another device, you must accept it on your device, as described in Receiving a Bluetooth Beam.
Bluetooth settings

To turn Bluetooth on or off:

1. Tap > Settings > Connections tab.
2. Tap Bluetooth.
3. Select On or Off. The Bluetooth radio is turned on or off according to your selection.

NOTE By default the Bluetooth radio is turned off. If you turn it on, and then turn off your device, the Bluetooth radio also turns off. When you turn on your device again, the Bluetooth radio turns on automatically.

Making your device discoverable

1. Tap > Settings > Connections tab.
2. Tap Bluetooth.

NOTES Other Bluetooth devices can now detect your device and attempt to beam information to it, establish a bond, or use a Bluetooth service. Note that to receive beamed information, you must accept it on your device.

Selecting Discoverable also turns on your Bluetooth radio.

If you no longer want your device to be discoverable, tap Off to turn off the radio or On to leave the radio on, but not allow detection by other devices.
Beaming information with Bluetooth

1. Tap and hold an item to beam, such as an appointment in Calendar, a task in Tasks, a contact card in Contacts, or a file in File Manager.
2. Tap Beam [type of item].
3. Tap the device to which you want to send the beam.
   The item is beamed to the device you selected.

**NOTE**
If the device that you want to beam to does not appear in the list, make sure that it is turned On, in discoverable mode, and within 10 meters (30 feet) of your device. Also, make sure that your Bluetooth radio is turned on.

Receiving a Bluetooth beam

1. Make sure that your device is configured to receive incoming beams.
2. Make sure that your device is **within 10 meters** (about 30 feet) of the device beaming the information and that Bluetooth is in **discoverable mode**.
3. When prompted to receive an incoming beam, tap **Yes**.
   The information is received on your device.
Federal Communications Commission Statement

This device complies with FCC Rules Part 15. Operation is subject to the following two conditions:

- This device may not cause harmful interference, and
- This device must accept any interference received including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with manufacturer’s instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

**WARNING!** The use of shielded cables for connection of the monitor to the graphics card is required to assure compliance with FCC regulations. Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate this equipment.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications.

This class B digital apparatus complies with Canadian ICES-003.
UL Safety Notices

Required for UL 1459 covering telecommunications (telephone) equipment intended to be electrically connected to a telecommunication network that has an operating voltage to ground that does not exceed 200V peak, 300V peak-to-peak, and 105V rms, and installed or used in accordance with the National Electrical Code (NFPA 70).

When using the Pocket PC, basic safety precautions should always be followed to reduce the risk of fire, electric shock, and injury to persons, including the following:

- **Do not use** the Pocket PC near water, for example, near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
- **Do not use** the Pocket PC during an electrical storm. There may be a remote risk of electric shock from lightning.
- **Do not use** the Pocket PC in the vicinity of a gas leak.

Required for UL 1642 covering primary (nonrechargeable) and secondary (rechargeable) lithium batteries for use as power sources in products. These batteries contain metallic lithium, or a lithium alloy, or a lithium ion, and may consist of a single electrochemical cell or two or more cells connected in series, parallel, or both, that convert chemical energy into electrical energy by an irreversible or reversible chemical reaction.

- **Do not** dispose the Pocket PC battery pack in a fire, as they may explode. Check with local codes for possible special disposal instructions to reduce the risk of injury to persons due to fire or explosion.
- **Do not** use power adapters or batteries from other devices to reduce the risk of injury to persons due to fire or explosion. Use only UL certified power adapters or batteries supplied by the manufacturer or authorized retailers.

Replaceable batteries

If an equipment is provided with a replaceable battery and if replacement by an incorrect type could result in an explosion (e.g. with some lithium batteries), the following applies:

- if the battery is placed in an OPERATOR ACCESS AREA, there shall be a marking close to the battery or a statement in both the operating and the servicing instructions;
- if the battery is placed elsewhere in the equipment, there shall be a marking close to the battery or a statement in the servicing instructions.

The marking or statement shall include the following or similar text:

```
CAUTION
RISK OF EXPLOSION IF BATTERY IS REPLACED
BY AN INCORRECT TYPE.
DISPOSE OF USED BATTERIES ACCORDING
THE INSTRUCTIONS
```

Compliance is checked by inspection.

Operator access with a tool

If a TOOL is necessary to gain access to an OPERATOR ACCESS AREA, either all other compartments within that area containing a hazard shall be inaccessible to the OPERATOR by the use of the same TOOL, or such compartments shall be marked to discourage OPERATOR access.

An acceptable marking for an electric shock hazard is  (ISO 3864, No. 5036)

Equipment for restricted access locations

For equipment intended only for installation in a RESTRICTED ACCESS LOCATION, the installation instructions shall contain a statement to this effect.